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ABSTRACT

As material balance control schemes are widely used in the industry to get a proper control
of distillation column. Material balance control in the direction of flow for distillation

column is basically used in the plants. So understanding variables to control and the
controller used is important for understanding the material balance control scheme. If
accumulator level will rise then the level controller will increase distillate rate. Same case for
the base level, if accumulator will raise then the level controller will increase bottom
product rate. Hence the type of feed forward used in the system is very important for

controlling the level in the distillation column.

In this project control scheme is used to get the best possible level control system. We will
look at the relationship between level control in the overhead condensate receiver and that

in the column base for several different column control schemes.

The study is aimed at understanding the material balance control scheme for the distillation
column and testing whether the control scheme which has been suggested is controlling the
level and compositions correctly or not. In particular, we are going to study a base case by
which we can show the control scheme which will give the controlled output and by using
the software (MATLAB) we will simulate the control scheme to get the results in the form of

graphs.
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Distillation column

Distillation columns are used in chemical and petroleum industries to separate chemical
components into more or less pure product streams. This separation is based upon the
differences in volatilities (tendencies to vaporize) among various chemical components. For
example, a mixture of methanol and water can be separated by a distillation column. More

volatile compounds are removed from the top of the column, and the less volatile, or heavier,
components are removed from the lower part of the column.

Fig.1.1
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Nomenclature and conventions for a distillation column.
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We will consider only a simple feed, two product columns separating a binary mixture.

Feed rate F moles per minute. Feed composition is zf mol fraction of the more volatile
component. The column trays are numbered from base upward, with feed introduced on the
N tray. The total number of trays in the column is Nr.

Products removed from the top and bottom of the column are called distillate or top product
respectively with flow rates D and B mol/min and compositions Xp and Xg mol fraction light
component.

Heat is transferred into the process in the reboiler to vaporize some of the liquid from the
base of the column. The heat transfer rate is qg energy units/time.

The vapour coming from the top of the column is liquefied in another tube and shell
exchanger called a condenser. Heat is transferred out of the condenser at a rate qc, btu/hr.

Liquid from the condenser drops in the reflux drum. Distillate product is removed from this
drum. In addition, some liquid called reflux (Lo, moles/min), is fed back to the top tray of the
column. This liquid reflux and the vapor boilup in the base of the column are necessary to
achieve the separation or fractionation of chemical components. The energy required to make
the separation is approximately the heat added to the reboiler.

One can stand back and look at the distillation column with its associated reboiler, condenser,
and reflux drum as a black box process. Feed, heat, and reflux are the inputs into this box.
Outputs from the box are the two product streams D and B with composition Xp and Xg. The
usual situation with distillation column is that the feed rate and feed composition must be
considered as disturbances. Heat input qgr and external reflux Lo can be adjusted to achieve
the desired control objectives. These are called manipulated variables. Distillate and bottom
product rates can also be manipulated, so there are four variables that can be adjusted, Lo, gg,
D, and B. They are not independent, however. If, for example, D is controlled, then B is
dependent.
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Need of control system for the distillation column

The central element in any control configuration is the process that we want to control.
Control objective are as follows-

e Ensuring the stability of the process

e Suppressing the influence of external disturbances
e Optimizing the economic performance of the plant
e A combination of the above

A column control system has three main objectives

e To set stable condition for column operation.

e To regulate conditions in the column so that the products always meet the required
specifications.

* To achieve the above objectives most effectively. This could mean maximizing
product recovery, minimizing energy consumption, and often both.

Variables typically controlled in a column are

e Flows

e Pressure

e Bottom level

e Accumulator level

e Top product composition

e Bottom product composition

These are classified into two groups —

1. Single loop variables — These include pressure and levels. They are controlled in
order to achieve the first objective that is, setting stable conditions for column
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operation. The set points at which these are controlled are established by stability
considerations alone, regardless of product specifications.

Controlling levels regulation material accumulation in the column

- Keeping the levels constant prevents liquid accumulation, while keeping the pressure
constant prevents vapour accumulation. Unless accumulation is prevented, a continuous
system will not operate at steady state and will not be stable.

1.  Unit objective variables -

These include top and bottom compositions. They are regulated to achieve the second
objective that is, meeting product specifications. The set points at which these are controlled
are determined by purity considerations alone. '

Composition controls can be direct, that is, using composition measurements of the product
streams, or indirect, using a physical property representative of product composition. Typical
physical properties used are refractive index, density, vapour pressure, freezing point, and,
most commonly, tray temperature.

2.  Manipulated streams

A stream is manipulated by varying the opening of its control valve. The stream flow rate
is thereby varied to control a desired variable. Figure shows five manipulates streams — top
and bottom product flow rates, condensation rate, boilup rate, and reflux flow rate.

A malfunctioning control system causes instability. The instability can adversely affect
product purity, column capacity, economy, and ease of operation. Instabilities are often
transmitted to downstream or upstream or upstream units, or can amplify small disturbances.
In extreme cases, instability can also lead to column damage or safety hazards.

Most of these strikes a balance between theory, practice, controls design, and controls
optimization. Computer controls and advanced controls are widespread and can be of primary
importance for column optimization, their role in setting stable operation is usually
secondary. Advanced controls often enhance column stability, but they seldom assure that the
primary stability objectives are met. A troublesome computer control loop can usually be
taken off control, and stable operation can be restored. On the other hand, an unstable basic
control loop usually means an unstable column, even when computer control is used.
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A column control philosophy that is either defective or unsuitable for the service is frequently
responsible for column instability. Prediction of column dynamic behaviour during the design
is extremely difficult, and designers resort to their previous experience in similar columns to
guide their control philosophy. Although relative gain analysis has proved invaluable for
control system synthesis; it is often helpless when data on column dynamic responses are
lacking.

Main Elements of Control system

Chemical process

It represents the material equipment together with the physical or chemical operations that
occur there.

The measuring instruments or sensor

Such instruments are used to measure the disturbances, the controlled output variables, or
secondary output variables, and are the main sources of information about what is going on in
the process.

In this project we are only dealing with the level control, so some of the instruments used for
measurement of level are as follows.

Level measurement

The measurement of level can be defined as the determination of the location of the interface
between two fluids, separable by gravity, with respect to a fixed datum plane. The most common
level measurement is that of the interface between a liquid and a gas. Other level measurements
frequently encountered are the interface between two liquids, between a granular or fluidized
solid and a gas, and between a liquid and its vapour.

*  Float-Actuated Devices - Float-actuated devices are characterized by a buoyant
member that floats at the interface between two fluids. Since a significant force is usually
required to move the indicating mechanism, float-actuated devices are generally limited to
liquid-gas interfaces. By properly weighing the float, they can be used to measure liquid-liquid
interfaces. Float-actuated devices may be classified on the basis of the method used to couple
the float motion to the indicating system as discussed below.

. Thermal Methods - Level-measuring systems may be based on the difference in
thermal characteristics between the fluids, such as temperature or thermal conductivity. A
fixed-point level sensor based on the difference in thermal conductivity between two fluids

Page 8 of 72




P

consists of an electrically heated thermistor inserted into the vessel. The temperature of the
thermistor and consequently its electrical resistance increase as the thermal conductivity of
the fluid in which it is immersed decreases. Since the thermal conductivity of liquids is
markedly higher than that of vapours, such a device can be used as a point level detector for
liquid-vapour interface.

e Sonic Methods - A fixed-point level detector based on sonic propagation
characteristics is available for detection of a liquid-vapour interface. This device uses a
piezoelectric transmitter and receiver, separated by a short gap. When the gap is filled with
liquid, ultrasonic energy is transmitted across the gap, and the receiver actuates a relay.
With a vapour filling the gap, the transmission of ultrasonic energy is insufficient to actuate
the receiver.

Transducers

Many measurements cannot be used for control until they are converted to physical quantities
such as:

i) Electrical voltage or current.
ii) Pneumatic signal that is compressed air or liquids.

which can be transmitted easily. Transducers are used for that purpose.

A pneumatic actuator converts energy (in the form of compressed air, typically) into motion.
The motion can be rotary or linear, depending on the type of actuator. Some types of
pneumatic actuators include:

o Tierod cylinders
» Rotary actuators

Transmission lines

These are used to carry the measurement signal from the measuring device to the controller. In
the past the transmission lines were pneumatic but with the advent of electronic analog
controllers and especially the expanding use of digital computers for control, transmission lines
carry electric signals. Many times the measurement signal coming from a measuring device is
very weak and cannot be transmitted over a long distance. In such case the transmission lines are
equipped with amplifiers which raise the level of the signal.
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The Controller

This is the hardware element that has intelligence. It receives the information from the
measuring devices and decides what action should be taken.

For example the controller decides whether that the flow rate of the outlet stream should be
increased or decreased in order to keep the liquid level in a tank at the desired value.

Between the measuring device and final control element comes the controller. Its function is to
receive the measured output signal Ym(t) and after comparing it with the set point Ysp to
produce the actuating signal C(t) in such a way as to return the output to the desired value Ysp.
| Therefore, the input to the controller is the error E(t)= Ysp-Ym(t), while its output is C(t). The
various types of continuous feedback controllers differ in the way they relate e(t) to C().

| The output signal of a feedback controller depends on its construction made may be a pneumatic
| signal for pneumatic controllers or electrical one for electronic controllers.

v
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Fig. 2.1 (a) Process and (b) corresponding feedback loop
The basic types of feedback controllers are
* Proportional controller
* Proportional integral controller
* Proportional integral derivative controller
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Proportional Control

A proportional controller moves its output proportional to the deviation in the controlled
variable from set point:

C(t) = KcE(t) + Cs

Where Kc = proportional gain of the controller
Cs= controller bias signal
E (t) = error

In some controllers, proportional gain Kc is expressed as a pure number; in others, it is set as
100/P, where P is the proportional band in percent. The output bias Cs of the controller is
also known as manual reset. The proportional controller is not a good regulator, because any
change in output to a change in load results in a corresponding change in the controlled
variable. To minimize the resulting offset, the bias should be set at the best estimate of the
load and the proportional band set as low as possible. Processes requiring a proportional band
of more than a few percent will control with unacceptable values of offset.

Proportional control is most often used for liquid level where variations in the controlled
variable carry no economic penalty, and where other control modes can easily destabilize the
loop. It is actually recommended for controlling the level in a surge tank when manipulating
the flow of feed to a critical downstream process. By setting the proportional band just under
100 percent, the level is allowed to vary over the full range of the tank capacity as inflow
fluctuates, thereby minimizing the resulting rate of change of manipulated outflow. This
technique is called averaging level control.

Proportional-plus-Integral (PI) Control

Integral action eliminates the offset described above by moving the controller output at a rate
proportional to the deviation from set point. Although available alone in an integral
controller, it is most often combined with proportional action in a PI controller:

C(t) = KeE() + Ke/tl [ E(t)dt+Cs

Where t1 is the integral time constant in minutes; in some controllers, it is introduced as
integral gain or reset rate 1/t1 in repeats per minute. The last term in the equation is the
constant of integration, the value the controller output has when integration begins. The PI
controller is by far the most commonly used controller in the process industries. The
summation of the deviation with its integral in the above equation can be interpreted in terms

of frequency response of the controller.
- The PI controller produces a phase lag between zero and 90 degrees.
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Proportional-plus-Integral-plus-Derivative (PID) Control

The derivative mode moves the controller output as a function of the rate-of-change of the
controlled variable, which adds phase lead to the controller, increasing its speed of response.
It is normally combined with proportional and integral modes. The no interacting form of the
PID controller appears functionally as:

C(t) = KcE() +Ke/tl [ E(t)dt+ KcTd dE/dt + Cs

where Td is the derivative time constant. Note that derivative action is applied to the
controlled variable rather than to the deviation, as it should not be applied to the set point; the
selection of the sign for the derivative term must be consistent with the action of the
controller.

In some analog PID controllers, the integral and derivative terms are combined serially rather
than in parallel as done in the last equation.

With the presence of the derivative term,(dE/dt), the PID controller anticipates what the error
will be in the future and applies a control action which is proportional to the current rate of
change in the error. Due to this property, the derivative control action is sometimes referred
to as anticipatory control.

The major draw backs of the derivative control action are the following-

1. For a response with constant non zero error it gives no control action since dE/dt=0.
2. For a noisy response with almost zero error it can compute large derivatives and thus
yield large action, although it is not needed.

Electronic Controllers —

Almost all of the electronic process controllers used today are microprocessor-based devices.
These processor- based controllers contain, or have access to, input/output (I/0) interface
electronics that allow various types of signals to enter and leave the controller’s processor.
The controller, depending on its type, uses sufficient read-only-memory (ROM) and
read/write-accessible memory (RAM) to perform the controller function. The resolution of
the analog I/O channels of the controller vary somewhat, with 12-bit and 14-bit conversions
quite common. Sample rates for the majority of the.constant sample rate controllers range
from 1 to 10 samples/second. Hard-wired single-pole, low-pass filters are installed on the
analog inputs to the controller to protect the sampler from aliasing errors.

Pneumatic Controllers —

The pneumatic controller is an automatic controller that uses pneumatic pressure as a power
source and generates a single pneumatic output pressure. The pneumatic controller is used in
single-loop control applications and is often installed on the control valve or on an adjacent
pipe stand or wall in close proximity to the control valve and/or measurement transmitter.
Pneumatic controllers are used in areas where it would be hazardous to use electronic
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R
equipment, in locations without power, in situations where maintenance personnel are more
familiar with pneumatic controllers, or in applications where replacement with modern
electronic controls has not been justified. Process-variable feedback for the controller is
achieved by one of two methods. The process variable can (1) be measured and transmitted to
the controller by using a separate measurement transmitter with a 0.2—1.0-bar (3—15-psig)
pneumatic output, or (2) be sensed directly by the controller, which contains the measurement
sensor within its enclosure. Controllers with integral sensing elements are available that sense
pressure, differential pressure, temperature, and level. Some controller designs have the set
point adjustment knob in the controller, making set point adjustment a local and manual
operation.

Other types receive a set point from a remotely located pneumatic source, such as a manual
air set regulator or another controller, to achieve set point adjustment. There are versions of
the pneumatic controller that support the useful one-, two-, and three-mode combinations of
proportional, integral, and derivative actions. Other options include auto/manual transfer
stations, anti reset windup circuitry, on/off control, and process-variable and set point
indicators. Pneumatic controllers are made of Bourdon tubes, bellows, diaphragms, springs,
levers, cams, and other fundamental transducers to accomplish the control function. If
operated on clean, dry plant air, they offer good performance and are extremely reliable.
Pneumatic controllers are available with one or two stages of pneumatic amplification, with
the two-stage designs having faster dynamic response characteristics.

The final control element

This is the element that implements in real life the decision taken by controller. For example,
if the controller decides that the flow rate of the outlet stream should be increased or
decreased in order to keep the liquid level in a tank at the desired value, it is the valve that
will implement this decision, opening by the commanded amount '
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Fig. 2.2 Elements of control system
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Closed loop control system

In a closed-loop control system, a sensor monitors the output and feeds the data to a computer
which continuously adjusts the control input as necessary to keep the control error to a
minimum. A closed-loop system uses the measurement of one or more process variables to

move the manipulated variable to achieve control. Closed loop systems may include feed
forward, feedback, or both

Advantages of closed loop control system are:

¢ Guaranteed performance even with model uncertainties, when the model structure
does not match perfectly the real process and the model parameters are not exact.
e Unstable processes can be stabilized.

e Reduced sensitivity to parameter variations.

Feedback Control -

In a feedback control loop, the controlled variable is compared to the set point R, with the
difference, deviation, or error e acted upon by the controller to move m in such a way as to
minimize the error. This action is specifically negative feedback, in that an increase in
deviation moves m so as to decrease the deviation (Positive feedback would cause the

deviation to expand rather than diminish and therefore does not regulate.) The action of the
controller is selectable to allow use on process gains of both signs.

Objective of feedback control system are
o To get the fastest possible response to set point.

e To compensate for or to attenuate disturbances as much and as quickly as possible.
These must be accomplished with a reasonable degree of closed loop stability.

Disturbances
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Fig.2.3 General Structure of feedback control configuration
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Feed forward Control —

A feed forward system uses measurements of disturbance variables to position the
manipulated variable in such a way as to minimize any resulting deviation. The disturbance
variables could be either measured loads or the set point, the former being more common.
The feed forward gain must be set precisely to offset the deviation of the controlled variable

from the set point.

Feed forward control is usually combined with feedback control to eliminate any offset
resulting from inaccurate measurements and calculations and unmeasured load components.
The feedback controller can either bias or multiply the feed forward calculation.
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Fig.2.4 General structure of feed forward control configuration

Page 15 of 72



Closed-loop transfer function

The output of the system y (t) is fed back through a sensor measurement F to the reference
value 7 (t). The controller C then takes the error e (difference) between the reference and the
output to change the inputs « to the system under control P. This kind of controller is a
closed-loop controller or feedback controller.

This is called a single-input-single-output (SISO) control system,;

MIMO (i.e. Multi-Input-Multi-Output) systems, with more than one input/output, are
common. In such cases variables are represented through vectors instead of simple scalar
values.

To avoid the limitation of single loop design and to provide a more flexible and sophisticated
process operating logic than can be implemented by human operators, we use an approach we
call multivariable control.

We define multivariable control system as one that has built in intelligence to look
simultaneously at two or more process variables and to choose in a given situation, the best
pre-programmed strategies for manipulating one or more control valves.

Fig.2.5 Closed loop system

If we assume the controller C, the process P, and the sensor F are linear and time-invariant
(that is elements of their transfer function C(s), P(s), and F(s) do not depend on time), the
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systems above can be analysed using the Laplace transform on the variables. This gives the
following relations:

Y{(s) = P(s)U(s)
U(s) = C(s)E(s)
E(s) = R(s) — F(s)Y(s).

Solving for ¥(s) in terms of R(s) gives:

P(s)C(s)
Y(s)= (1 n F(s)P(s)C(s)) R(s)

= H(s) R(s)

The expression represented by H(s) is referred to as the closed-loop transfer function of the
system.

___ P(s)C(s)
1+ F(s)P(s)C(s)

H(s)

The numerator is the forward (open-loop) gain from r to y, and the denominator is one plus the
gain in going around the feedback loop, the so-called loop gain.

References
Chemical Process Control by George Stephanopoulos

www.wikipedia.org
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MATERIAL BALANCE CONTROL FOR
DISTILLTION COLUMN
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Arrangements for material balance control

The size and location of tanks and the concept of overall material balance control used can
have a great influence on plant investment and process control. If the design engineer uses the
concept of control in the direction opposite to flow, tanks may be smaller and plant fixed
investment and working capital can be lower than if control in the direction of flow is used.

i [
I
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o~ /I' "“’“f&;%"

Fig.3.1 Material balance in the direction opposite to flow
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Fig.3.2 Material balance control in the direction of flow

When more than one tanks are involved, other advantages of control in the direction opposite
to flow are

1) Less difficulty with stability problems
2) Reduced internal turndown requirements
(Turndown as used here is the ratio of maximum required flow rate to minimum

required flow rate)

Once the basic concept of material balance control has been selected for a process, one must
apply the same concept to all process steps. It is for this reason that the first step in designing
column controls is to determine the material balance control arrangement. Control in the
direction of the flow is most commonly used concept.
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Fig.3.3 simple distillation column control system

Here level in the condensate receiver (reflux drum) sets the top product, or distillate flow,
while the level in the base of the column sets the bottom product flow. The direction of
material balance control is determined by the demand stream. In recycle stream we may find
some material balance controls in the direction of the flow while others in the direction

opposite to the flow.
Overhead system arrangements

The column overhead system is generally more complicated than either the feed system or the
bottom systems. It usually must condense the vapour flow from the top tray, remove inerts,
provide reflux flow back to the column, maintain column pressure in the right range, and
satisfy part of the material balance requirements.
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Condensate is generally subcooled at least slightly, partly to minimize the likelihood of
flashing and cavitation in valves and pumps, partly to control the amount of inerts in the
system, and partly to control product losses through the vent. Material balance control on the
condensate may be accomplished in several ways:

1) Flow control of reflux is cascaded, if possible, from column overhead composition,
and distillate overflows from the vapour liquid disengagement space beneath the

condenser.

2) Same as foregoing except that the distillate flow is set by reflux drum level control.

If a smooth flow to the next step in the process is needed, a reflux drum with averaging
level control of distillate should be employed.

Horizontal shell and tube condenser

This type of condenser with liquid coolant in the tubes and vapour on the shell side is
most common in petroleum refineries. By comparison with the vertical design, it is much
better suited to partially “flooded” operations. In addition, at startup time, column inerts
are usually vented more easily (with less pressure drop) through condenser of this design.
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COTLING
WATER
VENT
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i s et OSSR arets ees
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Fig.3.4 Horizontal condenser, vapour in shell
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| This design has two vents, each with a valve if the exchanger is operated flooded. Some
| designs bring the vapour in at one end and vent uncondensables at the other. Sometimes
| condensate is taken out through two drawoffs instead of one. The cooling water valve is
normally at the exchanger exit to make sure the tubes are filled at all times. Since the exit
water is hot, the valve may need anticavitation trim.Example showing the Overhead
system arrangement for atmospheric columns generally used in the petroleum industry.

Atmospheric columns

The condensed vapour falls into a reflux drum that should have 5-10 min. holdup (relative
| to condensate rate), and inerts are vented to a flare or cleanup system. At startup time
j total reflux may be achieved by using the reflux valve to control the level in the

condensate receiver.
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T /TL‘
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COOLING
WATER

i

ml__ C] DISTILLATE
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Fig3.5 Overhead system arrangement for atmospheric columns

A potential and frequent source of trouble with the arrangement is the control of
condensate temperature via cooling water. For a constant subcooled temperature, process
gain and dominant time constant both decrease as heat load increases. This compounds
stability problems, we need an increasing controller gain and decreasing reset time as
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total heat load increases. Further, subcooling heat load must be a reasonable fraction of
total heat load- say 5 percent- or the system will lack adequate sensitivity.

The suggested approaches to avoiding these difficulties are as follows:

1) Select the number of degrees of subcooling] so that the sensible heat load will be at
least 5 percent of the total heat load. This will have a secondary advantage of reducing
the probability of cavitation in control valves and pumps.

2) If water header fluctuations are a problem, use a cascade temperature water flow

control system.

Gravity return reflux vs pumped back reflux

With the condenser overhead, the vapour and reflux lines can be short, which favours
good compositional control. On the other hand, a ground level condenser is often easier to
maintain particularly where fouling is a problem. If an overhead condenser is used, a
more expensive column supporting structure is required, particularly if the overhead surge
drum is also located at the top of the column. The support problem can be minimized,
however, one uses the arrangement of direct return reflux and overflow distillate, then the
reflux does not come from overhead surge drum and this vessel can be located at ground
level. Since this tank with its contents is often far heavier than condenser, the condenser
can be located overhead with only modest increase in structural requirements over a
ground located condenser. Overall a properly designed gravity flow reflux systems, is
significantly cheaper than a pumped back reflux system, it is also probably safer since
there is no pump to fail.

Reflux flow or flow ratio control

When reflux is flow or flow ratio controlled, piping and instrumentation can be very
simple. Here reflux drum level is controlled by throttling distillate flow. A disadvantage,
unless the drum has a large cross section, is that variation in level will cause a momentary
change in both reflux and distillate flows. The reflux flow or flow ratio controller will
usually be fast enough that this will not be a problem for reflux flow. The level controller
on the other hand, may have to be cascaded to distillate flow control.
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Fig.3.6 Gravity flow reflux (flow controller) and distillate (level controlled)
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To avoid this problem, one may design a distillate overflow system that provides constant
head for reflux.

Here a vapour liquid disengagement space is built into the lower section of a vertical tube,
coolant in shell condenser. For maximum effectiveness the liquid pool in the vapour
liquid disengagement space should have large cross sectional area and the overflow weir
should permit a wide range of overflows with only a small change in head. Then, with the
head across the reflux line fixed, flow will vary only when the valve position is changed.
For this application a valve with linear trim will have a linear installed characteristic if
line drop is negligible; that is, a plot of reflux flow vs. valve stem position will be a
straight line. If the individual valve is shop calibrated, then the valve stem position can be

accurately related to reflux flow.

Since the surge tank needs a level controller, there is no savings in instrumentation, but
the equipment that needs to be installed at high elevation is minimized
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Column base and reboiler arrangements-

The design of the column base with its associated reboiler can be a complex matter. It
requires simultaneous consideration of fluid mechanics, heat transfer, mass transfer, and
process control. For example, the following must be considered when a vertical-
thermosyphon, forced —circulation or kettle- type reboiler is used.

Spacing between the vapour — return nozzle and the lowest tray should be large
enough to minimize entrainment of liquid drops in the rising vapour. This is typically
one vapour nozzle diameter and normally will be specified by the column designer.

The maximum liquid level should not be too close to the vapour nozzle as this
promotes turbulence in the liquid surface and liquid entrainment into the rising

vapour.

Minimum liquid level should not be too far below the vapour nozzle, or the falling
liquid drops will entrain too much vapour into liquid pool. In severe cases this may
cause foaming in the column base and gassing of the reboiler.

There should be a minimum liquid level depth the nozzle to the drawoff line from the
column base or vaporizer separator. This is required for two reasons- first, to permit
entrained vapour bubbles to rise and spate from the liquid pool, and second, to
minimize the like hood of vortex formation at the drawoff nozzle. Vortexing is
undesirable since it promotes entrainment of vapour into the drawoff line, which may
cause gassing of the reboiler or bottom product pump or circulating pump. Vortex
breakers should be installed routinely.

If level measurement nozzles are not protected by an internal damping chamber, they
should have an orientation no more than 90 deg from the vapour return nozzle and

should not be located under the down comer.

Material balance control scheme -

There are basically two types of arrangements-

1.

Material balance control in the direction of flow.

2. Material balance control in direction opposite to the flow.
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Procedure for designing control system for a distillation column

1. Start with writing the material balance for the binary distillation column.

2. Then after writing all the material balance equation for distillation column we will
find the transfer function for stripping section liquid and enriching section liquid.

3. Then we draw the signal flow diagram for distillation column material balance. By
using the material balance equation we combine all of them to form a signal flow

diagram.

4. We will find the overhead level and column base control equation of material balance
control scheme that is in the direction of flow. From these control and material
balance equation we draw the signal flow diagram for material balance in the

direction of flow.

5. Now showing the control scheme which has been made is controlling the level and
composition correctly or not. So we draw the basic diagram of the control scheme in
the software (MATLAB) with four manipulated variable with outputs are distillate
and bottom composition.

6. For ease of modeiling, it is assumed that the manipulated inputs are reflux flow rate
and vapour boil up rate.

7. By using data we can see the open loop behaviour for the control scheme. Then we
show the response to reflux change and response to boil up change.

8. Now we can plot the graph and see the response of control scheme over the bottom
composition and distillate composition.
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DISTILLATION COLUMN MATERIAL BALANCE

The feed wr, is split by the column into two parts; top product wp, and the bottom product,
‘ wg. It is assumed that vent losses overhead are negligible. It is further assumed that the heat
transfer dynamics of both the condenser and reboiler are negligible; this will be true for most

columns.
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Fig.3.7 Distillation column material balance
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Column base, including reboiler

{wi(s)- wy(s)-wa(s)}/s = Wa(s)

Where

W, = liquid flow from first tray, Ibm/min.
W, = vapor flow from column base, lbm/min
wp = bottom product flow, lbm/min.

W3 = liquid inventory in column base, Ibm, within the level transmitter span

s = Laplace transformation variable

Next:

Wg(s)/psAp = Hp(s)

ps = density, Ibm/ft3 of liquid in column base
Ag = cross sectional area of the column base, ft3

Hp = liquid level in base, feet

Feed tray-

The feed tray material balance in terms of molar flow is:

VREF (1-0) F VS ettt eq. 1
Where

Vi = vapor flow leaving feed tray, mol/min

F = feed flow, mol/min

Vs = vapor flow entering feed tray, mol/ Min

q = enthalpy factor
= (enthalpy of feed as vapor as dew point — actual feed enthalpy)/molar latent heat of

vaporization of feed
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(Ls-Lr)/ F
Lr = liquid flow from top tray, mol/min
Ls = liquid flow from feed tray, mol/min.

If the feed is a liquid at its boiling point, g=1 and Vr=Vs. If the feed is subcooled liquid, q is
greater than 1 and Vy is less than V.

It is also true that:

Vs + F+Lg =L+ Vg

From the definition of q above, we can write

L1 -Le=-Fq

In terms of weight units

W et1/(W ¢+1/L 7+1) = W/ (We'Lg) = =Wl (WHF) Queveninniniiieeeec e, eq. 2
we= feed, Ibm/min. |

Wt = liquid flow from the feed tray, Ibm/min.

From the eq. no. 2

We=[ W e/(Weni/L 1) + {we(we'F)} ql(wy/Ly)

Since wet1/L ¢+1,w¢F, and wy/L¢ are constants, we can rewrite equation in Laplace
transformation notation

wr (s) = (WoLo)(L e+1/W g:1)W £1(5) + (Wo'Le)(F/wi)qwi(s) + (we/Lg)(F/we)q(s) we

wr (s) = ka wit1(s) + ks wr (s) + kaq(s)

Usually k, =1, k3 = q, and k4 = wy

In going back to the equation no.1 and expressing it in weight units, we obtain.

Wit/ (Wet/VR) = We/(Wr/F)*(1-q) + wy/(w,/Vs)

Wit = (Wet/VR)*(Vs/w) *wy + (1-q)(F/wWr)* (Wet/VR)*W(s) —
(We-1/VR)*wr(F/wg)q(s)

W1 = kewy(8) + kywr(s) — kgq(s)

Usually k6 = 1, k; = 1-q, Kg= wr
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Stripping section liquid flow dynamics-

The transfer function between w; and wr is:

Wi(s)/wi(s) = G2 (s)

Where Gj(s) is the cumulative effect of the individual tray hydraulic lags,
Ga (s) = 1/ (tTgs +1) Ns =¢™2

Ns = number of trays from the column base to the feed tray

ay = NsTTR

Enriching section liquid flow dynamics-
We1(S)/Wir(s) = Gi(s)
Where

wir = liquid flow( internal reflux) from top tray, Ibm/min

Gi(s) = 1/(tTrs +1)Nr =e-*'*

Where

N = number of trays above the feed tray
al = NrtTg

WiRr = Kge WR

where

Ksc = 1+ ¢p/APT (To — TR)

WR = external reflux flow, Ibm/min.
Overhead material balance-

The vapor flow to the condenser is:

We(s) = Wei(s) — wi(s)[ cp/Aer (To — Tr)] |
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Where

Apr = latent heat of vaporization of process fluid specific heat, pcu/lb

cp = process fluid specific heat, pcu/lbm°C

To = average vapor temperature

Tr = average external reflux temperature

W, = vapor flow to condenser

If there is no subcooling w = w-1
Condensate receiver material balance
[We(s) — wp(s) — wr(s)]/s = W1(s)

Where

wp = top product flow rate, Ibm/min

Wr = condensate receiver inventory, lbm

If the condensate receiver is a vertical, cylindrical vessel:
Wr(s)/ prAt = Hr(s)

Where

Hr = height of liquid, feet, in receiver

pr = density of top product, [bm/ft’

At = cross sectional area of receiver, fi?
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Fig.3.8 Signal flow diagram for column material balance
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Control in the direction of flow-

Let condensate receiver level set top product flow and let column base level set bottom
product flow. We will assume that each level is cascaded to appropriate flow controller.

Fig.3.9 Distillation column with material balance control in direction of flow
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Overhead level control-

The necessary addition equation (no subcooling) is:
wp(s) = Hr(8)Kmnt Kent Gene(s) X 1/Kmm

where

Ko = distillate flow meter gain psi/lbm/min
12/(Wp)max

(Wp)max = top product flow meter span, Ibm/min.
Kene= controller gain

Geni(s) = controller dynamic gain

Kmnt = receiver level transmitter gain, psi/ft

From the signal flow diagram

wp(s)/[We(s) — Wr(s) = 1/[ 1 + (KeneGen(s)Km/ ATprK mfp)]

= KutGur(s)
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Fig.3.10 Signal flow diagram- condensate receiver
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Base level control-

wa(s) = (1/Kms) Kens Genp(s) Kmns Ha(s)

where

K = bottom product flow transmitter gain, psi/lbm/min
= 12/(wg)max ; (wg)max = flow meter span, lbm/min

Kch = controller gain

Kmng = base level transmitter gain

From the signal flow diagram, we see that

wa(s)/[wi(s)- wy(s)] = 1/[1+(Kcns Geng(s) Kmna/psAsKms)]

= Kup GHa(s)

Hg(S)

ppAuS

w,ls! A

Kmhs

(’cne(S.‘

Ko ‘*‘JKcnaQnE(S?""Q—'“

Fig.3.11 Signal flow diagram - column base
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Case study

A schematic diagram of typical binary distillation column is shown below. Notice that there
are four measured variable (distillate receiver level, base level, distillate composition, and
bottom composition) and four manipulated variable (reflux flow rate, distillate flow rate,
bottom flow rate, and reboiler heat duty). If feed is regulated then there is another
measurement (feed flow rate) and manipulated input (also feed flow rate). Normally it is
assumed that the distillate receiver level is controlled by manipulating the distillate prodlict
flow rate, and that the base level is controlled by manipulating the bottom product flow rate.
It is also assumed that these are tightly tuned, and the process outputs are perfectly controlled
at their set point values
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Fig. 3.13 Basic diagram of dual composition control scheme
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The column studied is 41 stage binary separation. For ease of modelling, it is assumed that
the manipulated inputs are reflux flow rate and vapour boil up rate. In practice the steam flow
rate to the reboiler would be manipulated, but it is related to the vapour boil up by heat of
vaporization of the bottom stream and the steam.

An input output transfer function model is

0878 —0.864 0394 0881 ]
. 3 H
[ﬂ‘n(“]x 75s+1 755 +1 || L05) +[mﬂ | F(-*)J

xgls)] | LO82 L% fy(s)| ") 0.586 1119 |, (y)
M5s+1  T3s+1

75s+1 75541

The outputs are the distillate xp and bottom xg composition, in mole fraction of light
component. The manipulated inputs are reflux (L) and vapour boil up (V) rates in kilo moles
per minute. The disturbance inputs are feed flow rate (F, k mole/min) and feed light
component mole fraction (zr). The unit of time are in minutes. The steady state compositions
are 0.99 and 0.01 mol fraction light component for the distillate and bottom product streams
respectively. The steady state manipulated inputs( reflux and vapor flow rates ) are 2.706 and
3.206 kmol/min respectively. The feed to the column is 1 kmol/min, with a feed composition
of 0.5 mol fraction light component and a feed quality of 1.

Open loop behaviour

Response to reflux change

Here we consider open loop step changes in the manipulated inputs, with additional time
delays of 2 minutes in the concentration measurement. The response of step change of + 0.01
k mole/min in reflux at t = 10 minutes, while keeping vapor boil up constant are shown in the

graph
Response to vapor boilup change

Response to the vapor boilup change is shown in the graph

References

Module 13 distillation control, process control modelling, design and simulation
B. Wayne Bequette.

Design of distillation column control Systems by Page S, Buckley, William L.
Luyben, Joseph P. Shunta.
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SOFTWARE (MATLAB) ASSOCIATED WITH

MATERIAL BALANCE CONTROL SCHEME

FOR DISTILLATION COLUMN
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MATLAB-

MATLAB is a high-performance language for technical computing. It integrates
computation, visualization, and programming in an easy-to-use environment where problems
and solutions are expressed in familiar mathematical notation.

Uses of MATLAB are as follows

Math and computation

Algorithm development

Data acquisition

Modelling, simulation, and prototyping
Data analysis, exploration, and visualization
Scientific and engineering graphics

Application development, including graphical user interface building

MATLAB is an interactive system whose basic data element is an array that does not require
dimensioning. This allows you to solve many technical computing problems, especially those
with matrix and vector formulations, in a fraction of the time it would take to write a program
in a scalar non interactive language such as C or FORTRAN.

The name MATLAB stands for matrix laboratory. MATLAB was originally written to
provide easy access to matrix software developed by the LINPACK and EISPACK projects.
Today, MATLAB engines incorporate the LAPACK and BLAS libraries, embedding the
state of the art in software for matrix computation.

MATLAB has evolved over a period of years with input from many users. In university
environments, it is the standard instructional tool for introductory and advanced courses in
mathematics, engineering, and science. In industry, MATLAB is the tool of choice for high-
productivity research, development, and analysis.
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MATLAB features a family of add-on application-specific solutions called toolboxes. Very
important to most users of MATLAB, toolboxes allow you to learn and apply specialized
technology. Toolboxes are comprehensive collections of MATLAB functions (M-files) that
extend the MATLAB environment to solve particular classes of problems. Areas in which
toolboxes are available include signal processing, control systems, neural networks, fuzzy
logic, wavelets, simulation, and many others.

The MATLAB System

The MATLAB system consists of these main parts:
e Desktop Tools and Development Environment

This is the set of tools and facilities that help you use MATLAB functions and files. Many of
these tools are graphical user interfaces. It includes the MATLAB desktop and Command
Window, a command history, an editor and debugger, a code analyzer and other reports, and
browsers for viewing help, the workspace, files, and the search path.

e The MATLAB Mathematical Function Library

This is a vast collection of computational algorithms ranging from elementary functions, like
sum, sine, cosine, and complex arithmetic, to more sophisticated functions like matrix
inverse, matrix eigenvalues, Bessel functions, and fast Fourier transforms.

o The MATLAB Language

This is a high-level matrix/array language with control flow statements, functions, data
structures, input/output, and object-oriented programming features. It allows both
"programming in the small" to rapidly create quick and dirty throw-away programs, and
"programming in the large" to create large and complex application programs.

e Graphics

MATLARB has extensive facilities for displaying vectors and matrices as graphs, as well as
annotating and printing these graphs. It includes high-level functions for two-dimensional and
three-dimensional data visualization, image processing, animation, and presentation graphics.
It also includes low-level functions that allow you to fully customize the appearance of
graphics as well as to build complete graphical user interfaces on your MATLAB
applications.

e MATLAB External Interfaces
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This is a library that allows you to write C and FORTRAN programs that interact with )
MATLAB. It includes facilities for calling routines from MATLAB (dynamic linking),
calling MATLAB as a computational engine, and for reading and writing MAT-files

Simulink

Simulink is software for modelling, simulating, and analyzing dynamic systems. Simulink
enables you to pose a question about a system, model it, and see what happens. With
Simulink, you can easily build models from scratch, or modify existing models to meet your
needs. Simulink supports linear and nonlinear systems, modelled in continuous time, sampled
time, or a hybrid of the two. Systems can also be multi rate — having different parts that are
sampled or updated at different rates. Thousands of scientists and engineers around the world
use Simulink to model and solve real problems in a variety of industries, including:

e Acrospace and Defense

e Automotive

o Communications

e Electronics and Signal Processing
e Medical Instrumentation

Tool for Model-Based Design

With Simulink, you can move beyond idealized linear models to explore more realistic
nonlinear models, factoring in friction, air resistance, gear slippage, hard stops, and the other
things that describe real-world phenomena. Simulink turns your computer into a laboratory
for modelling and analyzing systems that would not be possible or practical otherwise.
Whether you are interested in the behaviour of an automotive clutch system, the flutter of
an airplane wing, or the effect of the monetary supply on the economy, Simulink provides
you with the tools to model and simulate almost any real-world problem. Simulink also
provides demos that model a wide variety of real-world phenomena (see Simulink Demo
Models).Simulink provides a graphical user interface (GUI) for building models as block
diagrams, allowing you to draw models as you would with pencil and paper. Simulink also
includes a comprehensive block library of sinks, sources, linear and nonlinear components,
and connectors. If these blocks do not meet your needs, however, you can also create your
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own blocks. The interactive graphical environment simplifies the modeling process,
eliminating the need to formulate differential and difference equations in a language or
program. Models are hierarchical, so you can build models using both top-down and bottom-
up approaches. You can view the system at a high level, then double-click blocks to see
increasing levels of model detail. This approach provides insight into how a model is
organized and how its parts interact. '

Tools for Simulation

After you define a model, you can simulate it, using a choice of mathematical integration
methods, either from the Simulink menus or by entering commands in the MATLAB®
Command Window. The menus are convenient for interactive work, while the command line
is useful for running a batch of simulations (for example, if you are doing Monte Carlo
simulations or want to apply a parameter across a range of values). Using scopes and other
display blocks, you can see the simulation results while the simulation runs. You can then
change many parameters and see what happens for "what if" exploration. The simulation
results can be put in the MATLAB workspace for post processing and visualization.

Tool for Analysis

Model analysis tools include linearization and trimming tools, which can be accessed from
the MATLAB command line, plus the many tools in MATLAB and its application toolboxes.
Because MATLAB and Simulink are integrated, you can simulate, analyze, and revise your
models in either environment at any point.

How Simulink Interacts with MATLAB

Simulink is tightly integrated with MATLAB. It requires MATLAB to run, depending on
MATLAB to define and evaluate model and block parameters. Simulink can also utilize
many MATLAB features. For example, Simulink can use MATLAB to:

e Define model inputs.

e Store model outputs for analysis and visualization.

e Perform functions within a model, through integrated calls to MATLAB operators and
functions.
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Model-Based Design

Model-Based Design is a process that enables faster, more cost-effective development of
dynamic systems, including control systems, signal processing, and communications systems.
In Model-Based Design, a system model is at the centre of the development process, from
requirements development, through design, implementation, and testing. The model is an
executable specification that is continually refined throughout the development process.
After model development, simulation shows whether the model works correctly. When
software and hardware implementation requirements are included, such as fixed-point and
timing behaviour, you can automatically generate code for embedded deployment and create
test benches for system verification, saving time and avoiding the introduction of hand-

coding errors.

Model-Based Design allows you to improve efficiency by:

e Using a common design environment across project teams

e Linking designs directly to requirements

e Integrating testing with design to continuously identify and correct errors

¢ Refining algorithms through multidomain simulation

e Automatically generating embedded software code

e Developing and reusing test suites

e Automatically generating documentation

¢ Reusing designs to deploy systems across multiple processors and hardware targets

Modelling Process

There are six steps to modelling any system:

o Defining the System.

o Identifying System Components.

e Modelling the System with Equations.
¢ Building the Simulink Block Diagram.
e Simulating the Model.

e Validating the Simulation Results

You perform the first three steps of this process outside of Simulink before you begin
building your model.

Defining the System

The first step in modelling a dynamic system is to fully define the system. If you are
modelling a large system that can be broken into parts, you should model each subcomponent
on its own. Then, after building each component, you can integrate them into a complete
model of the system.

For example, the demo model used later in this guide models the heating system of a house.
This system can be broken down into three main parts;
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e Heater subsystem
e Thermostat subsystem
e Thermodynamic model subsystem

The most effective way to build a model of this system is to consider each of these
subsystems independently.

Identifying System Components

The second step in the modelling process is to identify the system components. There are
three types of components that define a system:

Parameters — System values that remain constant unless you change them
States — Variables in the system that change over time

Signals — Input and output values that change dynamically during the simulation

In Simulink, parameters and states are represented by blocks, while signals are represented by
the lines that connect blocks.

For each subsystem that you identified, ask yourself the following questions:
How many input signals does the subsystem have?

How many output signals does the subsystem have?

How many states (variables) does the subsystem have?

What are the parameters (constants) in the subsystem?

Are there any intermediate (internal) signals in the subsystem?

Once you have answered these questions, you should have a comprehensive list of the system
components, and are ready to begin modelling the system.

Modelling the System with Equations

The third step in modelling a system is to formulate the mathematical equations that describe
the system. For each subsystem, use the list of system components you identified to describe
the system mathematically. Your model may include:

Algebraic equations
Logical equations

Differential equations, for continuous systems
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Difference equations, for discrete systems
You use these equations to create the block diagram in Simulink.
Building the Simulink Block Diagram

After you have defined the mathematical equations that describe each subsystem, you can
begin building a block diagram of your model in Simulink.

Build the block diagram for each of your subcomponents separately. After you have modelled
each subcomponent, you can then integrate them into a complete model of the system.

Running the Simulation
The final step in modelling a system is to run the simulation and analyze the results.

Simulink allows you to interactively define system inputs, simulate the model, and observe
changes in behaviour. This allows you to quickly evaluate your model.

Validating the Simulation Results

After you simulate your model, you must validate that the model accurately models the
physical characteristics of the system. You can use the linearization and trimming tools
available from the MATLAB command line, plus the many tools in MATLAB and its
application toolboxes to analyze and validate your model.

Starting Simulink

MATLAB must be running before you can open Simulink. You start Simulink from within
MATLAB.

To start Simulink:

Start MATLAB. For more information, see Starting MATLAB in Getting Started with
MATLAB.

¢ Enter Simulink in the MATLAB Command Window.
e The Simulink Library Browser opens.
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Opening a model

You can open existing Simulink models or create new models from the Simulink Library

Browser.

To create a new model:

o Select File > New > Model in the Simulink Library Browser.

Simulink opens an empty model window.
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To open an existing model

e Select File > Open in the Simulink Library Browser. The Open dialog box appears.
* Select the model (.mdl file) you want to open, and then click Open. Simulink opens
the selected model in the model window.
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Simulink Library Browser

The Library Browser displays the Simulink block libraries installed on your system. You

build models by copying blocks from a library into a model window.
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Simulink Library Browser (Windows)
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Simulink Library Window (UNIX)
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Tips for Using the Library Browser

When using the Library Browser, note the following:

e You can view the blocks in a library by selecting the library name on the left side of

the Library Browser (on Windows), or by double-clicking the library.

e On Windows, when you select a block, a description of that block appears at the top

of the browser.

e For more information on a block, select the block, then select Help > Help on the
Selected Block to display the help page for the block.
e You can view the parameters for a block by right-clicking the block, then selecting

Block Parameters.On Windows, you can search for a specific block by entering the
name of the block in the block search field, then clicking the Find block icon.

Standard Block LibrariesSimulink provides 16 standard block libraries.
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The following table describes each of these libraries.

Block Library | Description
Commonly Used Blocks l Contains a group of the most commonly used blocks, such as the Constant, In1,
| Out1, Scope, and Sum blocks. Each of the blocks in this library are also included in
other libraries.
Contmuous o Contams blocks that model Ilnear functlons such as the Denvattve and Integrator
blocks.
Discontinuities Contains blocks with outputs that are discontinuous functlons ctﬂth-ehtr mputé such as
the Saturation block.
Discrete Contains blocks that represent discrete time functions, such as the Unit Delay block.
Logic and Bit Operations Contalns blocks that perform logic or bit operations, such as the Logical Operator
and Relational Operator blocks.
LookUp Tables Contains blocks that use lookup tables to determine their outputs from their inputs,
such as the Cosine and Sine blocks.
Math Operations Contains blocks that perform mathematical and logical functions, such as the Gain, |
Product, and Sum blocks.
Model Verification Contains blocks that enable you to create self-validating models, such as the Check
Input Resolution block.
Block Library Description
Model-Wide Utilities Contains blocks that provide information about the model, such as the Model Info
block.
Ports & Subsystems Contains blocks that allow you to create subsystems, such as the In1, Out1, and
Subsystem blocks.
Signal Attributes Contains blocks that modify the attributes of signals, such as the Data Type
Conversion block.
Signal Routing Contains blocks that route signals from one point in a block diagram to another, such
as the Mux and Switch blocks.
Sinks Contains blocks that display or export output, such as the Outt and Scope blocks
Sources Contains blocks that generate or import system lnputs such as the Constant In1 “
and Sine Wave blocks.
User-Defined Functions Contains blocks that allow you to define custom functions, such as the Embedded
MATLAB™Function block.
Additional Math & Discrete | Contains two additional libraries for mathematical and discrete function blocks.
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e
Simulink Model Window

The model window contains the block diagram of the model. You build models in the model
window by arranging blocks logically, setting the parameters for each block, and then
connecting the blocks with signal lines.

Fﬂe E&t wew Suw!ahon Format Tools Help

NGRS FBR[e9 492 ) il

N

C
Sine Wave
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1
—p g
Integrator

Fig 4.6

The model window also allows you to:

e Set configuration parameters for the model, including the start and stop time, type of
solver to use, and data import/export settings.
e Start and stop simulation of the model.Save the model.Print the block diagram.
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b
Adding Blocks to Your Model

To construct a model, you first copy blocks from the Simulink Library Browser to the model
window. To create the simple model in this chapter, you need four blocks:

Sine Wave — To generate an input signal for the model

Integrator — To process the input signal

Scope — To visualize the signals in the model

Mux — To multiplex the input signal and processed signal into a single scope
To add blocks to your model:

1. Select the Sources library in the Simulink Library Browser.
e On UNIX, double-click the Sources library.
e On Windows, select Sources in the left side of the Simulink Library Browser.

The Simulink Library Browser displays the Sources library.
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Fig 4.7

2. Select the Sine Wave block in the Simulink Library Browser, then drag it to the model
window.A copy of the Sine Wave block appears in the model window.
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Select the Sinks library in the Simulink Library Browser.

Select the Scope block from the Sinks library, then drag it to the model window.

A Scope block appears in the model window:.

Select the Continuous library in the Simulink Library Browser.Select the Integrator
block from the Continuous library, then drag it to the model window.An Integrator
block appears in the model window.

7. Select the Signal Routing library in the Simulink Library Browser.

8. Select the Mux block from the Sinks library, then drag it to the model window.A Mux
block appears in the model window.

S o el

Moving Blocks in the Model Window

Before you connect the blocks in your model, you should arrange them logically to make the
signal connections as straightforward as possible.

To move a block in the model window, you can either:

e Drag the block.
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e Select the block, then press the arrow keys on the keyboard.

Arrange the blocks in the model to look like the following figure.

A =

Sine Wave
Scope

Integrator

Fig 4.9

Connecting Blocks in the Model Window

After you add blocks to the model window, you must connect them to represent the signal
connections within the model. Notice that each block has angle brackets on one or both sides.
These angle brackets represent input and output ports:

e The > symbol pointing into a block is an input port.
e The > symbol pointing out of a block is an output port.

(nput port ==t % = b = Quitout port

Integtator

The following sections describe how to connect blocks by drawing lines from output ports to
input ports:

* Drawing Lines Between Blocks
e Drawing a Branch Line

Drawing Lines Between Blocks

You connect the blocks in your model by drawing lines between output ports and input ports.
To draw a line between two blocks:
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1. Position the mouse pointer over the output port on the right side of the Sine Wave
block.Note that the pointer changes to a crosshairs (+) shape while over the port.

- VH‘ N[
Sine Wave
-

Integrator

Fig 4.10

2. Drag a line from the output port to the top input port of the Mux block.

Note that the line is dashed while you hold the mouse button down, and that the pointer
changes to a double-lined crosshairs as it approaches the input port of the Mux block.

Sine Wave

A -———%fi =

1 Scope
XA =-D
8
Integrator

Fig 4.11

3. Release the mouse button over the output port.
Simulink connects the blocks with an arrow that indicates the direction of signal flow.
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4. Drag a line from the output port of the Integrator block to the bottom input port on the
Mux block.

Simulink connects the blocks.
5. Select the Mux block, then Ctrl+click the Scope block.
Simulink automatically draws the connection line between the blocks.

The model should now look similar to the following figure.

A\ Ui =
Sinmm
Scope
1
15
Integrator
Fig 4.13

Drawing a Branch Line The model is almost complete, but one connection is missing. To
finish the model, you must connect the Sine Wave block to the Integrator block. This final
connection is somewhat different from the other three, which all connect output ports to input
ports. Because the output port of the Sine Wave block already has a connection, you must
connect this existing line to the input port of the Integrator block. The new line, called a
branch line, carries the same signal that passes from the Sine Wave block to the Mux block.
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To weld a connection to an existing line:

1. Position the mouse pointer on the line between the Sine Wave and the Mux block.

|

|
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2. Press and hold the Ctrl key, then drag a line to the Integrator block's input port.
N\

Sine Wave l

]

Scope

1= 1 |
s

Integrator

The model is now complete. It should look similar to the following figure.
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‘ Simulink draws a line between the starting point and the input port of the Integrator block.
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Fig 4.14
Saving the Model

After you complete the model, you should save it for future use.

To save the mode]:

o Select File > Save in the model window.
* Specify the location in which you want to save the model.
* Enter simple_model in the File name field.
e Click Save.
Simulink saves the model with the file name simple_model.mdl.
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Simulating the model
Overview

After you complete the model block diagram, you can simulate the system and visualize the
results. This section describes how to simulate the sample model you created in the previous
section, creating a Simple Model.

Setting Simulation Options

Before simulating a model, you can set simulation options such as the start and stop time, and
the type of solver that Simulink uses to solve the model at each time step. You specify these
options using the Configuration Parameters dialog box.

1. To specify simulation options for the sample model:
e Select Simulation > Configuration Parameters in the model window.
o Simulink displays the Configuration Parameters dialog box.
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2. Enter 20 in the Stop time field.

3. Click OK.

Fig 4.15

Simulink applies your changes to the parameters and closes the Configuration Parameters

dialog box.

Running the Simulation and Observing Results

Now you are ready to simulate your example model and observe the simulation results.

To run the simulation:

e Select Simulation > Start in the model window.

Simulink runs the model, stopping when it reaches the stop time specified in the

Configuration Parameters dialog box.

e Double-click the Scope block in the model window.

The Scope window displays the simulation results.
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Fig 4.16
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Graph between distillate composition (y axis) and time (x axis)
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Graph between bottom composition (y axis) and time (X axis)
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Graph between distillate composition (y axis) and time (x axis) when there is change of :I:
.0lkmol/minute in reflux flow rate
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Graph between bottom composition (y axis) and time (x axis) when there is change of +

.01kmol/minute in reflux flow rate.
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Graph between distillate composition (y axis) and time (x axis) when there is change of +
.0lkmol/minute in vapour boil up
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Conclusion

From the above graphs it is clear that the signal flow diagram which has been made for one of
the control scheme is controlling the column properly.

The graph which has been made from the basic diagram of control system of the distillation
column is showing the correct results. Initially the composition is increasing from zero as the
production starts, then it becomes constant as the level of the top and the bottom composition
is adjusted according to the set point available. So the system is controlling in a proper
manner. The bottom and the top composition is adjusted by varying the reflux and vapour
boil up and we get more accurate graph.
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